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Email is a very\important tool at Harvey Mudd College. Many of us check our email
several times a day. We depend on it to communicate with colleagues, friends, and
family. Email is also being used more frequently to send more than just text. We send
word processing documents, image and sound files, and postscript files, among others.
Such files are usually sent as attachments. Dealing with attachments is a little different
than normal email and can cause some confusion and problems unless you understand
how they work. This article will cover the basics of sending and receiving attachments.

HOW DO ATTACHMENTS WORK?

The email system on the Internet is based on a protocol called SMTP (Simple Mail
Transfer Protocol). It was originally designed to handle only US-ASCII characters, the
set of 128 codes for the most common English characters, numbers and symbols. This
was not much of a problem when text messages were the norm, but is pretty limiting
today when people want to be able to send much more.

While some SMTP systems have been upgraded to handle more, you can't rely on all of
the mailers your message passes through being new, so to be safe, it is necessary to
encode the file first. Encoding systems such as binhex and uuencode were developed ft
this purpose, but required users to manually encode and decode the file themselves.

MIME, which stands for Multipurpose Internet Mail Extensions, was developed to deal
with the problem of sending non-US-ASCII data through email automatically. MIME
provides two types of encoding which use US-ASCII character codes to represent other
types of data.

An important aspect of MIME is that it uses a header field called “Content-Type” that
tells the mailer what type of information is contained in the message. The main content
types are: text, multipart, application, message, image, audio, and video.

The first type of encoding is called “quoted-printable.” Quoted-printable looks a lot like
regular text and is used for data that is mostly ASCII text, but that has some special
characters or very long lines. It works by replacing special characters with an “=" and
two characters that represent the character code of that special character. Quoted-
printable encoding could be used to send an email message in French, for example,
where all of the accented characters would be treated as special characters.

The other type of encoding is called “base64.” Base64 is used for non-text data such as
image and sound files. It uses an encoding algorithm to translate the binary data of thes
files into a subset of the US-ASCII character set.

As an interesting aside, MIME was coauthored by an HMC alum, Ned Freed (class of
'82), who also helped write PMDF Mail along with Kevin Carosso (class of '82) and
Daniel Newman (class of '85). c@ntinued on page)5
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When you first start using email it’s pretty the commercialization of the Internet, but
cool. You send email to your friends, Usenet was also affected. An increase in
family, and colleagues, you subscribe to athe amount of spam and junk mail has been
lot of mailing lists that look interesting,  an unfortunate consequence.

and suddenly you're receiving 50-100

email messages a day, if not more. After Recently, spamming has come to refer to
that you get to be a little more cautious. sending unsolicited junk email to a large

You unsubscribe from some of those number of email addresses. The spammers
mailing lists, and reading your email use a variety of sources for email
becomes something of a daily chore addresses. They use programs to scan

instead of the fun task it was when you Usenet and pull addresses frpostings
first started. So when you start receiving and worms to crawl the Web looking for
unsolicited email from total strangers you addresses on Web pages. They also buy and
are understandably a bit annoyed. How diskell lists like paper junk mailers.
these people get your email address and
who are they anyway? WHAT CAN | DO TO AVOID JUNK EMAIL?

As we mentioned before, the people who
SPAM AND JUNK EMAIL: A BRIEF HISTORY send junk email often construct their
When the Internet was in its infancy and address lists from addresses they have
funded by the NSF, commercial activities found on Web pages and newsgroup
and advertising were basically banned. Thaostings. If you don’t have a Web page that
World Wide Web didn’t exist then, so the lists your email address and you don’t post
guestion of advertising was mostly to the Usenet newsgroups, you may avoid
confined to the Usenet community some of the junk email out there. One
(newsgroups) and mailing lists. Posting artactic some people use is to alter their
advertisement about an unrelated productemail address in their newsgroup postings
to a newsgroup was considered to be an by adding extra words or characters that
off-topic intrusion on the discussion. Evenhave to be removed in order for the email
worse was “spam.” Spamming was (and
still is) considered to be one of the cardindl THE ORIGIN OF THE TERM ““SPAMMING””
sins. Spamming refers to the practice of

posting the same message, usually The term came from the Monty Pythop
advertisements and get-rich-quick sketch in which the characters go to 4

schemes, to a large number of newsgroupsrestaurant that serves mostly,spam, i.p.
one after the other. “spam, eggs, spam, beans, and spam.”

Every time the waitress recites the
When the NSF relinquished control and tlemenu she is drowned out by achorus|of

Internet became more popular and Vikings chanting the Word’::spéfﬁ” ovey
accessible to the general public, increased and over again. Spam postings were
commercialization was inevitable. The felt to drown out.the legitimate contenf

World Wide Web played the largest role in| of newsgroups.




address to be valid. For example, adding
the words “nospam” in the middle of your
email address is popular. It's pretty hard t
avoid junk email completely though. As
we’ve all noticed in the world of postal
mail, once you are on a mailing list
somewhere you tend to end up on a lot of
mailing lists for junk mail. A similar
phenomenon seems to be developing witl
junk email. Often all you can do is hit the
Delete key!

At HMC we recently added a new feature
to the way our main UNIX server, Orion,
processes email. A lot of junk emailers us
bogus email addresses to avoid complain
Orion no longer accepts email from bogus
domains. So mail from addresses like
“hi@your.friend.com” will no longer be
accepted by Orion. We hope this
modification to Orion’s email system will
significantly reduce the amount of junk
mail you receive if you us@rion. Don't
worry, though, you will still receive all your
email from valid addresses.

WHO CAN | COMPLAIN TO?

If the email comes from a valid domain
name you can write to the email address
“abuse@domain.name” where you would
replace domain.name” with the actual
domain name of the junk email you
received. You should include the full text
of the message you received, including al
of the header information. Most service
providers are pretty good about yanking
the accounts of people who abuse their
accounts. If that address doesn’t work you
can also try postmaster@domain.name.”
Unfortunately, a lot of junk email comes
from bogus email accounts.

If you'd like more information on spam
and junk mail you can read the article
“Advertising on Usenet: How To Do It,
How Not To Do It” located on the
News.announce.newusers official archive
athttp://www.netannounce.org/
news.announce. newusers/. %
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Once again, email is the topic of
this month’s issue dDccasional
Downtime Questions and problems witk
email account for a large portion of the
phone calls and email to the AC Help
Desk so it seems appropriate to set asi
more time and space to this topic than
others.

Email attachments, in particular, cause
problems for many of our users so we
have devoted an entire article to the
subject of how attachments work and
how to send and receive them.

Other articles in this issue focus on the
issue of spamming on the Internet and
on a new email protocol called IMAP.

In addition to these articles on the topic
of email we have the solution to last
month’s crossword puzzle, some tips oI
using the new version of the operating
system for the Macintosh, Mac OS8,
and our usuauestions and Answers
section.

—Elizabeth Hodas

Occasional Downtimes published bimonthly
by the Academic Computing Department 3
Harvey Mudd College. It is also available in

variety of formats on the HMC Web Server,

Comments and questions can be directed
downtime@hmc . edu.
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A new.email protocol

Until fairly recently we have had two typescentral server, but uses a client program on
of mail programs available at HMC. The the desktop to access the mail. IMAP

first type is the traditional system in whichaddresses the main disadvantage of POP,
all of your email is received, stored and however. While the IMAP client still runs
read on the host computer. Pine, EIm,  on the desktop computer, the email

VMS Mail, and PMDF Mail are all remains on the central server rather than
examples of this type of email program. being downloaded to the desktop
computer.

The second type of system is based on

POP (Post Office Protocol) in which mail An IMAP client program behaves very

is received on the mail server and then much like a POP client in that it allows the
downloaded on demand to a desktop user to read and create new messages; to
computer running an email client programcreate, delete and rename mailboxes for
Eudora is an example of this type of emaiktoring mail; to check for new mail; and to
program. (For more information on these search for specific mail messages. All of
two types of email systems you can read these functions are performed within a

the article on email in the inaugural issue desktop program with familiar menus and
of the newOccasional Downtimé’E-Mail  windows. The fact that the mail remains on

at Harvey Mudd College: Or is it just the server is transparent to the user, but
Greek to you?Occasional Downtime users do not have to worry about backups
Volume 3, Issue 1, April 1995.) and can access both their new and archived

mail from multiple locations.
Eudora has become very popular on
campus due to its ease-of-use. The main Qualcomm recently released a new version
advantage to POP-based email programsof Eudora Pro for Windows 95 which
like Eudora is that they allow the user to supports IMAP, Eudora Pro 4.0 (Eudora
read and send their mail on their desktop Pro is the commercial version of Eudora).
computer within a user-friendly interface. Unfortunately, the Macintosh version does
The disadvantage is that the email is no not yet support IMAP. Macintosh users
longer stored on a central server. This  will have to wait for the next version of
means that users are responsible for Eudora for IMAP support. IMAP support
backing up their email on their own and is not planned for the freeware version of
that they are not able to access their stordéudora.
mail from other locations.

Academic Computing has not yet tested
Academic Computing has recently Eudora Pro 4.0 for Windows 95, but hopes
upgraded the mail servers on both the  to do so over the summer. There are
VMS cluster Thubar) andOrion. They several other IMAP clients which we are
now support a third type of email system investigating, such as the email client
called IMAP. IMAP stands for Internet included with Microsoft’s Internet
Message Access Protocol. IMAP is similatExplorer. However, we hope that Eudora
to POP in that it is based on a client-servewill meet our expectations since it is
4 | model in which mail is received on a already widely in use on campgs;




Attachments continued from page 1 on the Macintosh, or the Options dialog
box under the Tools menu on the PC.
HOW DO | SEND AN ATTACHMENT? Choose an encoding method based on th
How you send an attachment depends in email program and operating system the
large part on the email program that you recipient of your message uses (see the t
use. In general, though, the email progranbox for tips on choosing an encoding
takes care of most of the work of sending method). It's your responsibility to find out
and receiving an attachment. All you havewhat kind of setup the recipient has. (If
to do is tell the program you want to sendyou can'’t find out, then AppleDouble on
file and then specify which file you want tadhe Macintosh and MIME on the PC are
send. The mailer takes care of encoding tpeobably the best choices.)
file and attaching it to your message.
Usually the file does not appear in the body Once you’ve done this step, attaching a fi
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of your message, but is attached as a “rideris as easy as creating a new email message

The recipient’s mailer will then take care of and then selecting “Attach Document”
decoding it and detaching it from your under the Message menu. In the file dialo
message when it receives the message. box locate and select the file you want to
send. The path to the file should appear ir
Sound too easy to be true? Well, thisis  the Attachments field in the header of the

how it would work in an ideal world, and message, but the file will not appear in the

when both the sender and the recipient udedy of the message. That is normal.
compatible email programs it can actuallyRemember, attachments are usually attache
be this easy. Problems arise when the  to the message as a rider. You can still type
sender and the recipient do not have message in the body of the email and then
compatible email programs. For example,send it as usual.

if the sender’s email program is MIME-

compliant but the recipient’s mail programlf someone sends you an attached

is not. Or if the sender uses a Macintosh, document, Eudorécontinued on page 7)
but the recipient uses a PC. Or if the sender

uses a PC, but the recipient has a UNIX
workstation. In most of these cases it is ATTACHMENT TYPES
still possible to send and receive the
attached file, but more care has to be take MACINTOSH

to do it right. AppleDouble: best for recipients with
MIME-compliant email readers
ATTACHMENTS WITH EUDORA regardless of operating system.

Since Eudora is one of the more widely AppleSingle: best for recipients with
used email programs on campus, we’ll us| MIME-compliant email readers on

it as an example. To send and receive Macintoshes. Not suitable if the
attached files in Eudora you first need to | recipient is using a PC.

do some preliminary configuration. For BinHex: best for recipients who are
sending attachments you need to tell using a Macintosh, but who don’t have

Eudora what encoding method you wantt a MIME-compliant email reader.
use. For receiving attachments you need
tell Eudora what directory on your hard PC

drive you want detached files to be put inf MIME: best for recipients with MIME-
(usually the Attachments Folder inside the compliant email readers, regardless of

Eudora directory). Both of these operating system.
configuration settings are located by BinHex: best for recipients who are
selecting the Attachments icon in the using a Macintosh, but who don’t have

Settings dialog box under the Special mer a MIME-compliant email reader.
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ACROSS DOWN
2. The only category of software not 1. lllegal copying of software
protected by law 3. A popular Macintosh anti-virus
4. A type of license for commercial program
software 5. Desktop publishing software
10. Mathematics software 6. Eudora aliases
13. The most common macro virus 7. Law protecting intellectual property
16. To remove a computer virus 8. Bruce Willis’ favorite file virus
18. Mailing list command to find out the 9. Novell file server
lists you are subscribed to 11. Opposite of destructive or malicious
20. A deceptive computer program virus
21. Eudora publisher 12. Mailing list software
22. Program for controlling access to 14. Most common type of PC virus
commercial software at HMC 15. Software you pay for if you decide to
use it
17. New Academic Computing UNIX
machine

19. Not a real virus



will normally automatically decode and

Attachments continued from page 5 ® T
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detach the document and put it in the

directory you've designated. You’'ll know

you've received an attachment from the MAC 0S8 TIPS

message Eudora inserts at the end of the Last semester we offered a workshop

email message saying that the document introducing the new operating system for

was detached and identifying the filenameahe Macintosh, Mac OS8. If you missed

You just need to open your attachments the workshop here are some of the

directory to locate the file. You can then highlights:

open the file in the appropriate application,

i.e. Microsoft Word for a word processing v The Finder is now truly multi-tasking sg

document or a graphics application for an that you can perform multiple copy

image file (see th®&A section in this operations simultaneously, empty the

issue for more on opening attachments).  Trash, and still navigate through Finder
windows without having to wait.

WHEN THINGS DON’T WORK v Choose the Simple Finder option (in the

Sometimes Eudora can’'t automatically Finder Preferences dialog box under the

detach and decode an attached document. Edit menu) for simplified Finder menus
This is usually because it was encoded v Menus are now “sticky.”

using a method that Eudora doesn’t handle. Control-click on an item in the Finder
For example, Eudora Light, the freeware  for useful contextual menus.

version of Eudora, cannot decode v Use the Appearance and Desktop
uuencoded files (uuencode is an encoding Pictures control panels to customize
method used primarily on UNIX systems). your Macintosh’s look.

So you need to manually detach the v Use the Windowshade control in the toj
document by saving the message as a file right corner of a window to quickly
and then use a separate utility to decode  collapse the window. Option-click the
the file. For example, Stuffit Deluxe and windowshade control to collapse all
UULite for the Macintosh and Wincode for windows in an application (including

the PC will decode a uuencoded file. the Finder).

v Folders are now “spring-loaded’—drag
ATTACHMENTS IN OTHER EMAIL PROGRAMS an item over the hard drive or a folder
Pine, which is available on both UNIX and and it pops open automatically. You car
VMS machines on campus, is another also “tunnel” through nested folders by
popular email program on campus. Pine is double-clicking and holding (similar to
a MIME-compliant email program and Option-double-clicking in System 7.6).

allows you to send and receive attachmentsy Drag a folder window to the bottom of
You can check the online Pine documenta-  the desktop to create a pop-up window
tion for details on how to do it. The main v You can view the contents of a folder in
difference is that since most attached files are list view, as icons, or as buttons. Use th
Macintosh and PC files you will need to FTP View Options dialog box to customize
the file from the UNIX or VMS mail server your folder view.

to your Macintosh or PC before you can v Option-drag an item to copy it to a new

open it in the appropriate application. destination; Command-Option-drag an
item to place an alias to the item at a
Attachments are an extremely useful new destination=/

feature of today’s email programs. We
hope this article has better prepared you
for both sending and receiving thefw;
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UESTIONS and

Q: How do | take a screen shot of my

A:

computer screen?

On a PC just press the Print Screen A:
key. Then open the Paint program and
select Paste from the Edit menu. To
print it select Print from the File menu.
On a Macintosh press Command +
Shift + 3 (all three keys at the same
time). Double-click the hard drive icon
and look for a file called Picture 1. (If
you take multiple screen shots, they’ll
be numbered sequentially.) Double-
click the file to open it in SimpleText.
To print it select Print from the File
menu.

. | tried to logon taKato and | get an

error message saying that I'm already
logged on. | know | logged out on the
last machine | used. What's going on?

If the last computer you used was a
Windows NT computer, it may not be
properly configured. We have had
numerous reports of students not being
logged off fromKato properly after
logging off from Windows NT. In the
short term you can have yokiato
logon “killed” so that you can logon to
Kato. In the long term you should
install Novell’s Client 32 software on
the Windows NT box to stop this
problem from happening again. The
software can be located on Novell's
Web site ahttp://
support.novell.com/products/
nt4i1/ .

. 1 got an attached document by email.

Eudora detached it and put it in my
Attachments folder. | tried double-
clicking on the file, but all I get is an
error message saying that | don’t have

the right application. What am | doing
wrong?

The problem is probably that the
document you were sent was created
using an application that you don’t
have on your hard drive or was created
using a different version of the
software that you use. This often
happens with word processing
documents. Even at HMC several
different versions of both Word Perfect
and Microsoft Word are commonly
used.

The easiest solution to this problem is
to launch the word processing program
that you do have on your hard drive
and then try to open the document from
within the application. For example,
launch Microsoft Word, then go to the
File menu and select Open. In the file
dialog box locate the document in the
Attachments directory and click Open.
Most word processing programs will
convert documents created in other
programs and allow you to open them.

If you use Microsoft Word 6.0 and the
document was created using Microsoft
Word 97 the solution is not quite as
simple. Microsoft does provide a
converter which will convert Word 97
documents to make them compatible
with earlier versions of their software.
The converter is available on their Web
site athttp://www.microsoft.com/.
We also have Microsoft Word 97
available on the AC file servefato,

and in the AC Pentium computer lab.
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